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Welcome to BTV Pro!

BTV Pro is an application for the Macintosh that allows you to 
view, capture and edit video, create stop-motion animations, and 
also has advanced capture features such as frame averaging, time 
lapse and motion detection. It works with any Macintosh 
compatible video input source such as video input cards, TV 
cards, built-in video, USB, DV, and FireWire video sources.

Introduction
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Viewing modes

Live video can be displayed either in a window that can be 
resized and dragged around the screen, or full screen on an 
entire monitor.

You can adjust the size and mode of the video display using the 
'Video size' menu:

There are five preset video sizes. Initially these sizes are set up 
depending on the capabilities of your video hardware (the menu 
shown above shows the default sizes for PAL format video). 
These video sizes apply to both window mode and full screen 
mode. You can enter your own values for these preset sizes by 
choosing ‘Video sizes...’ from the menu.

When you switch to full screen mode, the ‘Go to full screen 
mode’ item changes to ‘Go to window mode’, allowing you to 
switch back to window mode.

When in full screen mode you can select the ‘Fill the screen with 
video’ option - BTV Pro will attempt to fill the screen with as 
much video as possible (depending on your screen resolution 
and capabilities of your video hardware).

Viewing video
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Full screen resolution

There are two resolutions to consider for full screen video: 
monitor resolution and video resolution. The video resolution 
you are using is fixed and depends on your video hardware and 
the video format. Your monitor has several different resolutions 
for you to choose from. When you go to full screen mode BTV 
Pro automatically switches your monitor to the desired 
resolution, and switches it back again when going to window 
mode..

If you are using a video source with a maximum size of 
640x480, such as from a USB camera or NTSC format video, a 
monitor resolution of 640x480 should be used so that the video 
completely fills the screen.

If you are using PAL format video then a monitor resolution of 
800x600 should be used and the video displayed at the maximum 
size of 768x576 centred on the monitor. This results in a small 
black border around the edge of the video but will give you the 
best viewing quality.

Initially, BTV Pro automatically attempts to choose the best 
monitor resolution, but you can change the monitor settings at 
any time from under the ‘Monitor settings’ tab in the 
preferences (see page 73).

Viewing 16:9 widescreen video

Video normally has an aspect ratio of 4:3, however widescreen 
video has a wider aspect ratio of 16:9. Since most video inputs 
are designed to work with 4:3 video, when viewing widescreen 
video there will be black borders at the top and bottom. BTV 
Pro can crop the top and bottom of the video to remove these 
borders. You can turn this option on and off by going to ‘Video 
Sizes’ under the Video Size menu (see the picture below).

If you are viewing widescreen video from a DV source on a 
widescreen monitor (such as the Apple Cinema Display) you can 
display the video fullscreen by doing the following: select any 
widescreen monitor resolution in the preferences, turn on 
cropping for widescreen video in the Video Sizes window 
(below), and then switch to full screen mode and select ‘Fill the 
screen with video’ from the Video Size menu. This setup only 
needs to be done once.
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Multiple monitor support

If you have more than one monitor attached to your computer 
you can view full screen video on any monitor.

You can choose which monitor is used to display full screen 
video under the ‘Monitor settings’ tab in the preferences (see 
page 73).

Disabling screensavers

When viewing full screen video it is desirable to disable any 
screensavers installed on your system so that your viewing is not 
interrupted. This is done by shifting the mouse position 
periodically, therefore tricking the screensaver into thinking 
that the machine is being used.

Note that for screensavers to be disabled in this way the mouse 
must be hidden.
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QuickTime Movies

The QuickTime Movie file format

Invented by Apple Computer, the QuickTime Movie file format 
is the industry standard file format for the storage, transfer and 
playback of time-based media on Macintosh Computers, and it is 
also widely used on the PC. It is a very flexible file format that 
has ability to store many different types of time based media 
such as video, sound, text, video effects, MIDI data, time code, 
and animations. BTV Pro creates QuickTime movie files 
containing video and sound.

Virtually all video-related Macintosh software works with 
QuickTime files, so you can to capture video with BTV Pro and 
then open it with another video application. Also, BTV Pro can 
open any QuickTime movie made by any other application.

References

Movies do not necessarily contain all of its data in a single file; 
one movie may contain references to several other movie files, 
or references to data elsewhere in the movie. This is useful 
because it allows data to be included in movies without 
increasing the movie’s file size, since the data isn’t actually in 
the movie itself but rather just pointed to by a reference.

If you have a movie that contains references to other files then 
all the files must be present for the movie to be played back 
properly. When you open such a movie BTV Pro attempts to 
find all the files; if any of the files cannot be found you will be 
asked to find them manually.

To make a movie self contained with no references to other 
files, select ‘Save as...’ from the File menu and turn on the 
‘Flatten’ option.

BTV Pro creates references when you use copy-and-paste 
operations to edit movies (see page 43). It also uses references 
when it splits movie captures into several files (see page 27).
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Streaming

Streaming is the process of playing a movie while it is being 
received over a network from a remote location (for example, 
over the Internet). This is different from Fast Start movies; the 
streamed video is transferred over the network in real time and 
is not saved to the computer’s hard disk. Streamed video is 
broadcast by a Streaming Server.

To create movies in BTV Pro that can be streamed by a 
Streaming Server, first choose suitable video and sound 
compression codecs (see page 23). Then export the movie as a 
Hinted Movie. This adds an extra Hint Track to the movie that 
enables the Streaming Server to stream the movie over the 
network. To export the movie choose “Export movie...” from 
the File menu.

Transferring files to a Microsoft Windows PC

If the PC has QuickTime installed it will be able to read any 
image file created by BTV Pro, and any ordinary captured 
movie. It will also be able to read DV stream files. However, 
movie files created by time lapse or motion detection capture, 
and new movies created by the 'New movie' command in the 
File menu, are Macintosh-only and can't be read on a PC. To 
allow these movie files to be read on a PC you need to either 
flatten them or export them (see page 42).

When transferring files to a PC always make sure that you have 
added the file extension (.jpg .mov .dv etc) to the end of the file 
name so that the PC can recognise the file type. File extensions 
can be added for you automatically if this option is set in the 
preferences (see page 64).

Fast Start movies

This is a method of saving a QuickTime movie in such a way 
that it can be played back from the hard disk at the same time as 
it is being downloaded from a network (such as the Internet). 
You can create Fast Start movies by using the ‘Export Movie...’ 
command from the File menu.
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Video format settings

There are a variety of video capture format settings which are 
available by selecting “Video settings...” from the Settings menu. 
You will see the following window (below is the left hand side 
of the window; the right hand side contains a small display of the 
current video input):

Capture format settings

Note that these settings only apply to recorded movies, not live 
video viewing. All settings are explained below.

1

2

3

4

5

6
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Spatial compression

Spatial compression is a method of reducing the storage space 
needed for an image (or a frame of video in this case) while 
maintaining image quality as much as possible. There is always a 
tradeoff between storage space and image quality.

Compression methods are referred to as “codecs” because they 
specify both a compression and a decompression scheme.

Spatial compression can significantly reduce the size of captured 
files, and can improve capture and playback speed since the rate 
of transfer of data to and from the hard drive is reduced. A 
measure of the amount of compression provided by the codec is 
the compression ratio. For example, if a compressed image uses 
half its original storage space then the compression ratio is 2:1.

Under the Compressor menu in the Video Settings window 
(above) there are a number of different compression codecs.The 
compression codec chosen here applies whenever frames are 
being added to movies: normal video capture, adding individual 
frames to movies, motion detection capture and time lapse 
capture.

See below for detailed information about each compression codec 
available.

Lossless and lossy compression

Spatial compression codecs are either lossless or lossy. A lossless 
compression codec is one that does not loose any data when it 
compresses an image – the original image can be perfectly 
reconstructed from the compressed data. Conversely, a lossy 
compression codec is one that looses data when it compresses an 
image – the original image can never be reconstructed perfectly 
from the compressed data.

Lossless compression codecs are suited for computer-generated 
images where there are large areas of constant colour. Lossy 
compression codecs need to be used to obtain good compression 
ratios for a photograph-type image, such as one in a stream of 
live video. Most spatial compression codecs are lossy.

1



11

When capturing video it is almost always better to use lossless 
compression instead of no compression at all; it can reduce the 
file sizes, therefore reducing the load on the hard disk and 
computer, with no loss of image quality. It works by exploiting 
spatial redundancy within the image. For example, a completely 
black frame of video would be stored as one large black area 
instead of many individual black pixels.

Applying compression more than once

Each time an image is compressed by a lossy compression codec 
it looses some quality, so it is desirable to keep the number of 
times it is compressed as low as possible. If you are capturing 
video (or images) that are likely to be recompressed by a lossy 
compression codec in the future is it a good idea to choose a 
lossless (or at least high quality lossy) compression codec for the 
initial compression. This produces high file sizes initially but 
ensures that the quality of the final output is as high as possible.

Colour depth

Some compression codecs support many different colour depths. 
Generally, the lower the colour depth the smaller the resulting 
file sizes. Colour depths are named by the number of colours 
that are used in the image. Here is a complete list of depths that 
could be available, depending on the compression codec:

Black and white (1 bit)
4 Greys (2 bit)
4 Colours (2 bit)
16 Greys (4 bit)
16 Colours (4 bit)
256 Greys (8 bit)
256 Colours (8 bit)
Thousands of colours (16 bit)
Millions of colours (24 bit)
Millions of colours+ (32 bit)

Sometimes the available options are named just “Colour”, or 
“Greyscale”. In this case “Colour” means either 8, 16, 24, or 32 
bit colour (depending on the compression codec) and 
“Greyscale” means 8 bit greyscale. There is also sometimes an 
option named “Best Depth”, in which case video is captured at 
the highest depth available.

2
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Temporal compression

Depending on the content, video can have a high level of temporal 
redundancy, that is, very often one frame is quite similar to the 
next frame. Temporal compression exploits this redundancy to 
reduce the file size of the resulting movie. The success of 
temporal compression depends very much on the content of the 
video; if adjacent frames are very similar then file sizes can be 
significantly reduced but if adjacent frames in the video are 
generally quite different then the video is not suitable for 
temporal compression.

Quality

All lossy compression codecs have a quality setting. The higher 
this setting the better quality the resulting image, but the more 
storage space is used. For compressing video to be sent over the 
Internet it is necessary to turn down the quality setting so that 
the resulting movie is small.

Frame rate

You can enter a desired frame rate in the Video Settings window 
for captured video. This frame rate applies to normal video 
capture as well as motion detection capture.

If you leave this box empty, video is captured at the maximum 
possible rate. The maximum rate you will be able to obtain 
depends on your video input hardware, the speed of your 
computer and hard disk, and the type of compression codec in 
use.

Reducing the frame rate proportionally affects the file size of the 
captured video, so for transmission of video over the internet it is 
advisable to limit the frame rate so that the file size of the 
resulting movie is small.

3

5

4

32 bit images do not contain any more colour information than 
24 bit images, so 32 bit images are no higher quality than 24 bit 
images. The difference is that 32 bit images contain an extra 8 
bit “Alpha Channel”. This Alpha Channel holds transparency 
information, so when displaying the image on top of another 
image the Alpha Channel determines how the two images are 
combined.
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Temporal compression works by using “key frames” at regular 
intervals, followed by several “delta frames”. The key frames 
contain the complete video image, the delta frames only contain 
the portions of the image that have changed since the last key 
frame.

For compression codecs that support temporal compression you 
can enter a key frame rate in the Video Settings window. Note 
that the key frame rate that you enter here is the minimum key 
frame rate that is used; if the compressor codec decides that more 
key frames should be used it will do so (for example, if there is a 
segment of the video with a low temporal redundancy many key 
frames will be used but a different segment of the video with high 
temporal redundancy only the specified rate of key frames will be 
used).

Limiting the data rate

Some compression codecs allow you to enter a value to limit the 
data rate (also referred to as the “bit rate”). This is useful when 
creating a movie that will be transferred of streamed over the 
Internet, so that you can make sure that the file size of the 
resulting movie is small. When you enter a value in this field the 
codec will automatically adjust its quality setting during 
compression to try to obtain the desired data rate.

6
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Available video compression codecs

The number of compression codecs you have available in BTV 
Pro depends on the version of QuickTime that is installed on your 
computer. Below is a list of codecs that are available if you have 
QuickTime 4 or later installed on your computer:

None
No compression at all, so results in very large inefficient files. It 
is preferable to use a lossless compression codec instead, such as 
the Animation codec at maximum quality. Supports all colour 
depths. Does not support spatial compression.

Animation
Best suited for computer-generated animations with broad areas 
of constant colour. It is lossy at quality settings below maximum, 
but at the maximum quality setting it is lossless and therefore 
generally used as an intermediate work format. Supports all 
colour depths. Supports temporal compression.

Component video
Fast compression and decompression, lossless, but low 
compression ratio (2:1). Sometimes referred to as the “YUV” 
codec. Good as an intermediate storage format but not as a 
delivery format. Supports 24 bit colour only. Does not support 
temporal compression.

Video
Very fast compressing and decompressing with reasonable 
compression ratios. Suitable for capturing video to the hard disk 
with high frame rates but unsuitable for compressing video for 
transmission over the Internet. Supports 16 bit colour. Supports 
temporal compression.
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DV-NTSC and DV-PAL
Used with digital camcorders. DV-NTSC is used by devices 
manufactured in the US and Japan, and DV-PAL is used by 
devices manufactured in Europe. Some DV camcorders offer a 
“Progressive Scan” feature that records each frame as a single 
non-interlaced image instead of two separate interlaced fields. 
This is vastly superior for viewing video on a computer monitor 
so it should always be used when filming DV footage that will be 
viewed on a computer. DV compression is similar to JPEG 
compression but is more efficient. Supports 24 bit colour only. 
Moderate decompression speed and compression ratios. Does not 
support temporal compression.

Sorenson
Produces highly compressed video ideal for transfer or streaming 
over the Internet. Achieves higher image quality at lower data 
rates than other similar compression codecs. Very efficient at data 
rates ranging from 2 to 200 KBps. Very slow to compress and 
required quite a fast computer for smooth playback, especially if 
the video size is large or the data rate is high. When using 
Sorenson you should make sure that the horizontal and vertical 
video dimensions are a multiple of 4. Supports 24 bit colour only. 
Supports temporal compression and data rate limiting.

Motion JPEG A and Motion JPEG B
Commonly used by hardware Motion JPEG compression cards. 
(There is very little difference between the A and B variants). 
Compresses the two fields of interlaced images separately, as 
opposed to Photo JPEG which is for non-interlaced images. Often 
used as storage formats for large files that need to be archived 
with good quality; it is lossy but at maximum quality the image 
degradation is minimal. Quick to compress and decompress, with 
reasonable compression ratios. Supports 24 bit colour, and 
greyscale. Does not support temporal compression.

Photo JPEG
Generally used for high quality still non-interlaced images but it 
is too slow to decompress to be used for video playback. Useful 
for intermediate high quality storage of video with good 
compression ratios. Works well for slide-show type movies that 
require a low frame rate and high quality compression. Supports 
24 bit colour, and greyscale. Does not support temporal 
compression.
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Cinepak
Designed in 1990 for the Macintosh computers of the day, this 
codec is therefore very quick to decompress on modern 
computers (it is quite slow to compress however). It is a good 
choice if the video has to be played back on older computers, but 
otherwise other codecs (such as Sorenson) offer higher quality at 
lower bit rates. Suitable for Internet transfer or streaming. Uses a 
compression ratio of at least 10:1, supports 8 and 24 bit colour, 
and greyscale. Supports temporal compression and data rate 
limiting.

H.261
Designed originally for video conferencing, so it is optimised for 
low data rates and for video that contains a small amount of 
motion (high temporal redundancy). Quick to compress and 
decompress, with very high compression ratios. Suitable for 
Internet transfer or streaming. Supports 24 bit colour only. 
Supports temporal compression and data rate limiting.

H.263
Similar to H.261 but optimised for video sizes of 352x288, 
176x144, or 128x96. It is better than H.261 at higher bitrates.

Indeo Video 4/5
Primarily designed for Windows, so can be used to transfer video 
between Mac and PC without requiring QuickTime to be installed 
on the PC. High image quality and high compression ratios, but 
quite slow to compress and decompress and image quality of 
Sorenson is generally better. Supports 32 bit colour only. 
Supports temporal compression and data rate limiting.

Graphics
Similar to the Animation codec, but only for 8 bit images. It is 
usually better than the Animation codec for 8 bit images but it is 
slower to decompress. Supports temporal compression.

BMP
Used for still images; inappropriate for video playback. Does 
minimal compression, supports most colour depths. Does not 
support temporal compression.

Planar RGB
Lossless compression, therefore low compression ratios. Supports 
8, 24, and 32 bit colour depths. Does not support temporal 
compression.
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Still image format settings

The same spatial considerations apply to still images as to 
frames of video, but of course the temporal considerations do 
not. While video frames are compressed with a certain codec 
and then stored in a QuickTime Movie file, a single image is 
stored in its own file of a specified format.

Image file formats available in BTV Pro are:

PICT
The standard Macintosh image file format. Lossless 
compression, so produces quite large files. Supports all colour 
depths.

JPEG
Very widely used lossy image compression format that produces 
high quality images at low file sizes (there is a quality setting to 
adjust the amount of compression). You should always use this 
format for photographic type images that will be transferred 
over the Internet or put on web sites. Supports 24 bit colour, 
and greyscale.

TIFF
Traditionally used for images produced by scanners, this is a 
widely used file format. Can choose either lossless compression, 
or no compression at all. Produces quite large files, supports 
most colour depths.

BMP
Microsoft Windows Bitmap file format. It is lossless; use this 
when you want to transfer lossless images to a PC. Supports 
most colour depths.

PNG
Designed as a replacement for the popular GIF file format 
(which is a very useful format but is protected by a patent so 
that any manufacturer of software that produces GIF files has to 
pay a licence fee to the inventors of the format). PNG works 
well for computer generated images with a limited number of 
colours, but also can be used for photographic type images. It is 
lossless and supports all colour depths.
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Sound format settings

PSD (Photoshop)
This is the native file format for the very popular industry 
standard image editing application, Adobe Photoshop. 
Convenient to use if the images are to be imported straight into 
Photoshop after capture. Lossless compression, supports 8, 24 
and 32 bit colour

The JPEG, TIFF, PNG, BMP and PSD file formats are all 
commonly used on Windows PCs and so should be readable on 
any PC with graphics software, even if it does not have 
QuickTime installed on it. BMP and JPEG files should definitely 
be readable as these are standard formats on the PC. Make sure 
when transferring the images to a PC that you have added the 
three character file extension (.jpg .tif .png .bmp or .psd) to the 
file name so that it can recognise the file type.

There are a variety of settings for sound capture, all of which 
are available by selecting “Sound settings...” from the Settings 
menu. You will see the following window:

1

2

3
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4

5

6

Use these controls to 
select the sound input 
source from which 
you would like to 
record sound. The 
number and type of 
options you have in 
these menus depends 
on your sound 
hardware.
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Sound compression

This is similar to image compression in that sound compression 
reduces the data rate of digital audio at the expense of quality, 
but since sound is continuous (not discrete, like frames of video) 
it cannot be temporally compressed and all sound compression 
schemes are lossy.

The best sound compression schemes work on a principal known 
as “Perceptual Encoding”. The idea is that the codec removes 
the data in the sound that humans cannot hear, therefore 
significantly reducing the amount of data while maintaining 
sound quality. Perceptual Encoding schemes can achieve very 
high compression ratios (10:1 or higher) without much loss of 
quality.

The audio codecs available in BTV Pro that use perceptual 
encoding are called “QDesign Music” and “Qualcomm 
PureVoice” (see below for more information about these 
codecs).

Sound channel volume setting

This volume affects the volume of live sound but does not affect 
the volume of captured sound.

Gain

This gain setting allows you to compensate for the volume of 
your sound source if it is too high or too low. This setting does 
affect the volume of captured sound.

2

1

3
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Sample frequency

Sound is continuous variations in air pressure that is converted 
to an analogue electrical signal by a microphone, and finally 
sampled and stored by the computer. When a sound wave is 
recorded on a computer it undergoes sampling. That is, at 
regular intervals the value of the sound wave is measured and 
stored, so that the computer builds up a digital representation of 
the sound wave.

The higher the sample frequency the more of the audio 
spectrum is accurately recorded.

Using low sample rates cause noise to be introduced into the 
signal and reduces the range of audio frequencies that can be 
represented by the samples, so it is desirable to use a high 
sampling rate.

The sampling rates available depend on your sound input 
hardware. Typical sample rates are 11kHz, 22kHz and 44kHz. 
44kHz is the sample rate used in audio CDs and it can accurately 
reproduce the entire audio frequency range of human hearing.

Mono / stereo setting

Recording in stereo uses two sound channels and therefore uses 
more storage space, so if you are using a mono sound source is 
is best to switch this setting to mono

Sample size

The other factor that determines the quality of sampling is the 
sample size. Each sample is stored on the computer as a number 
of bits. The higher the number of bits used to store a sample the 
more accurate the sampling is. Using a low number of bits 
introduces what is called “quantisation noise” into the sound. 
Audio CDs use 16 bit sample sizes.

4

5

6
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Available sound compression codecs

The number of compression codecs you have depends on the 
version of QuickTime that is installed on your computer. Below is 
a list of codecs that are available if you have QuickTime 4 or later 
installed on your computer:

None
No sound compression. The sound is recorded with the sample 
rate and bit depth specified without loss of quality, producing 
high data rates.

QDesign Music
Excellent for music. Very high compression ratio and high 
quality. Good choice for internet transfer and streaming.

Qualcomm PureVoice
Excellent for voice. Very high compression ratio and high 
quality. Good choice for internet transfer and streaming.

ALaw 2:1
An Internet standard for compressed audio everywhere except in 
the US and Japan. Low compression ratio and low quality. 
Generally not recommended.

uLaw 2:1
An Internet standard for compressed audio in the US and Japan. 
Low compression ratio and low quality. Generally not 
recommended.

MACE 3:1 and MACE 6:1
Older Macintosh compressors. Low quality. Generally not 
recommended.

IMA 4:1
Good quality reproduction of music and other audio content. 
Supports 16 bit samples only. Relatively low compression ratio.

32 bit Floating Point and 64 bit Floating Point
Increases the sample size to 32 or 64 bits. This allows for more 
accuracy when converting to other sample sizes and applying 
effects, therefore producing less quantisation noise.

24 bit Integer and 32 bit Integer
Increases the sample size to 24 or 32 bits. Only specialist 
professional audio hardware uses 24 or 32 bit audio.
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Settings for sending files over the Internet

Although the speed of internet connections are getting faster all 
the time, the majority of people around the world use modems 
for connecting to the internet. Sending large files (such as 
movies and images) over a slow modem connection can take a 
long time, so it is necessary to make the file sizes of your 
movies and images small before you send them over the 
internet. The following settings are suggested:

Settings for still images

Use the JPEG format for still images. This produces small files 
and since JPEG is such a popular file format (on both Mac and 
PC) there should be no problem with viewing the file at the 
other end.

Settings for video

Video compression *
Use the Sorenson codec at medium to low quality. This produces 
small file sizes at higher quality than any of the other 
compression codecs available.

Video frame rate
Limit the frame rate of the capture by typing in a value for the 
frame rate in the Video Settings window. This can make a big 
difference to the file sizes so use the lowest frame rate that is 
acceptable.

Video size
Use the smallest video size that is acceptable. Halving the video 
dimensions results in four times fewer pixels in the image, so 
this makes a big difference to the file size of the movie.

Settings for sound

Sound compression *
If the sound is speech then use Qualcomm PureVoice; if the 
sound is music then use QDesign Music. Both allow you to 
adjust the bit rate (quality setting), so choose a medium to low 
bit rate.
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Sound sample settings
Use 16 bit, 22KHz sampling. This gives you reasonably high 
quality and small file sizes with the above sound compression 
codecs

* The above compression setting require a lot of processing 
time, so if you are applying the compression on-the-fly as the 
movie is captured then you will get low frame rates unless you 
are using a very fast computer. In this case you can capture 
video in an intermediate format that is quick to compress, and 
then use the Export command (under the File menu) to 
compress the movie to your final compression settings.

As an intermediate format you can use Component Video, 
Animation (at maximum quality), Video (at high quality), 
Motion JPEG A (at high quality), or DV (if you are using DV 
video) for video compression, and no sound compression.

Remember when sending files to a Windows PC to include the 
three letter file extension that tells the PC what type of file it is. 
For JPEG files the extension is .jpg and for movie files the 
extension is .mov. BTV Pro can add these file extensions for 
you if this option is turned on in the preferences (see page 64).
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Capturing movies and images

All options for capture are available from the Capture menu:

There is also a floating window that contains frame capture and 
movie capture controls. This is available from the Window 
menu:

Capturing still images

When you choose 'Capture frame' from the Capture menu or 
from the floating window, an image is captured from the video 
input and saved straight to the hard drive with an automatic 
name and destination. The destination and naming settings that 
you have defined in the preferences are used (see page 66).

Alternatively, when the video input window is at the front, 
choosing 'Save' or 'Save as...' from the File menu will display a 
window allowing you to choose a destination for the file, as well 
as the file format and other options.
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Capturing QuickTime Movies

When you start capturing a movie it is saved to the 
destination(s) that you have supplied and an automatic name is 
created for it. For information about adjusting the movie 
capture settings see the preferences (page 69).

There is an option in the preferences to display a settings 
window before every capture. This allows you to adjust all the 
capture settings before every capture:

These settings are the same as the movie capture settings available 
in the preferences. For more information about any of these 
settings please see the preferences section of this manual
(page 69).

During video capture the Capture Controls window shows the 
elapsed time:



27

If you have many hard disks connected to your computer you can 
define up to three destinations for video capture; when the first is 
full the second is used and when that is full the third is used.

When the capture has been split into several files an index is 
added to the files so that you know the order in which they were 
captured. For example, if the main file name is “My Movie” then 
the other files are named “My Movie-01”, “My Movie-02” etc. 
You can only open the first file but it contains the data of all the 
files.
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Frame averaging

The frame averaging feature takes a number of frames from the 
video input and blends them together to produce a single image. 
This can eliminate noise on a still image capture and is useful in a 
number of situations such as capturing noise-free still images from 
a digital camera, capturing clean images from a noisy VHS video, 
or even to remove a moving element in a video sequence (for 
example, if a sequence of video shows a street with a person 
walking down it then averaging all the frames removes the person 
and reduce any video noise in the image of the street).

Frame averaging works because the image is constant but the noise 
is quickly varying so over many frames it averages to zero. See the 
following examples:

A noisy video 
signal.

Averaged over 40 
frames



29

Image from a camera
in low light

Averaged over 50 frames

It is also worth noting that due to the removal of noise the file 
size of the averaged image is often significantly smaller than the 
size of the normal still capture.

The number of frames used for averaging is adjustable in the 
preferences (see page 66). The frames are taken from the video 
input and processed as fast as possible but because some 
processing has to be done on each frame, the frame rate you 
obtain when averaging depends on the speed of your computer.

BTV Pro also has a feature to average a number of frames in a 
movie rather than the live video input. This gives more control 
over exactly which frames are used in the averaging process. To 
do this, select a portion of an open movie and select ‘Average 
selected frames’ from the Movie menu.
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Time lapse capture

1

2

3

4

5

7

8

9

The time lapse feature schedules the capture of a number of 
frames over a period of time at precise intervals. To start a time 
lapse select ‘Time lapse...’ from the Capture menu; you will get 
this setup window:

Interval between captures
This is the time interval between frame captures. From the 
popup menu you can choose either ‘Time’ to enter the time 
between captures in the format hours:minutes:seconds, or 
‘Seconds’ to enter the number of seconds between captures.

1

6
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Time lapse duration
You can choose to limit the duration of the time lapse. From the 
popup menu you can choose either ‘Time’ to enter the duration in 
the format hours:minutes:seconds, or ‘Captures’ to enter the 
number of captures. If you do not limit the duration then the time 
lapse will continue until it is stopped manually.

Multiple capture/averaging
You can choose to capture or average a certain number of frames 
each time interval. If the capturing goes on too long (longer than 
the time interval) it will be stopped so that the time lapse does not 
get behind schedule.

Draw clock on captured frames
If this option is on then an image of a clock is drawn on every 
frame. Clicking the ‘Clock options...’ buttons shows this window:

2

3

4

5

Preview
This option controls whether the video is played to the window 
during the time lapse capture. Turning preview off shortens the 
time it takes to average frames and slightly increases the accuracy 
of the time lapse.

6

Warning sound before capture
If this option is on an audio warning is played before each frame 
capture. From the popup menu you can choose a number of beeps 
to play before each capture.
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Create movie / separate image files
You can choose to create either a movie with the captured 
frames, (in which case the normal movie capture settings are 
used) or you can choose to create separate image files (in which 
case the normal frame capture settings are used).

FPS of movie
If you are creating a movie, this defines the FPS (frames per 
second) of the frames in the created movie.

Settings
This popup menu allows you to create sets of different time 
lapse settings.

7

8

9

During the time lapse there is a progress window like the one 
below that shows you the number of frames captured, elapsed 
time, remaining time, countdown to next frame, and averaging 
progress (if you are averaging frames every capture). There is 
also an option to turn on and off preview at any time during the 
time lapse:

You can choose to display an analogue and/or digital clock, and you 
can adjust the size of the clock and the position in the image.

If the timelapse is capturing a movie the clock is drawn onto a 
second video track in the movie so that it does not wipe out the 
image behind it so therefore can be removed later, or 
disabled/enabled at playback. If the timelapse is creating separate 
image files, the clock is drawn over the actual image.
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Motion detection

1

2

4

5

3

This feature constantly analyses the video input and only captures 
video when there is motion. To start a motion detection capture 
select ‘Motion detection...’ from the Capture menu; you will get 
this setup window:

Motion bar
This bar indicates the amount of motion in the video.

1

2 Trigger level
When the amount of motion in the video goes above this trigger 
level video is captured.

6
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Preview
This option controls whether the video is played to the window 
while it is captured. Turning this option off gives you better 
responsiveness and capture performance.

Delay to stop capturing
Once motion is detected and video is being captured, this delay 
controls how long to wait before stopping the capture after the 
motion has stopped.

Sensitivity
Increasing the sensitivity produces a larger effect for the same 
amount of motion. At the highest setting it is extremely 
sensitive, so very small amounts of motion can be detected.

4

5

3

When motion is detected, video is captured with the frame rate 
and compression settings specified in the Video Settings window 
(click the ‘Video Settings...’ button in the motion detection 
window above for these settings). Since analysing the image for 
motion requires some processing time a fast computer is needed 
to get a high frame rate.

During the motion detection, a progress window displays the 
duration of video captured and the number of separate 
segments. There is also an option to turn on and off preview at 
any time during the motion detection:

Draw clock
You can choose to draw a clock on all frames, or on a blank 
frame when motion is detected just before a segment of video is 
captured. See page 31 for more details about clock settings.

6
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Processing digital video involves moving, calculating and storing 
extremely large amounts of data compared to other kinds of 
computer files. To get the most out of your computer you should:

• Turn off Virtual Memory (using the Memory control panel in 
the Control Panels folder under the Apple Menu).

• Turn off AppleTalk (using the Chooser under the Apple Menu).

• Eject all removable disks.

• Make sure that you are using the latest version of the driver 
software from the manufacturer of your video input device.

• Never use no video compression. If you use no video 
compression then the amount of data that your computer has to 
move around and store to the hard disk is very large, resulting in 
low frame rates. If you want no loss of quality then it is always 
better to use a non lossy compression codec (such as Animation at 
maximum quality) rather than no compression at all, since it 
results in a lower data rate and produces a smaller movie file. 
Alternatively you can use a fast lossy codec at a high quality 
setting, such as Motion JPEG A or Video.

• Use the compression codec that is supplied by your video input 
device if it supplies compressed video. Some devices supply video 
in compressed form, such as DV sources which supply DV-PAL 
or DV-NTSC, USB sources and FireWire (not DV) cameras 
which commonly supply Component Video, and some PCI sources 
which supply Motion JPEG. You can set the compression codec by 
choosing ‘Video Settings...’ from the settings menu (see page 9). 
Doing this ensures that you get the optimum frame rate and no 
image degradation due to recompression of the video. To see if 
your video input hardware supplies compressed video select 
‘Video hardware information...’ from the Apple menu and this 
shows a window that displays the default codec.

• If you are using compression codecs that require a lot of 
processing time (such as Sorenson video) then you will get a low 
frame rate when using them for on-the-fly compression. In this 
case you can capture video in an intermediate format that is quick 
to compress, and then use the Export command (under the File 
menu) to compress the movie to your final compression settings.

Video capture performance



36

• When you capture video make sure that BTV Pro is the only 
application loaded, and that you have a minimum number of third 
party (non-Apple) extensions installed on your computer. You can 
disable extensions using the Extensions Manager (in the Control 
Panels folder under the Apple Menu).

• For best performance make sure you defragment your hard 
drive regularly. Defragmenting your hard drive makes all the 
free space continuous, so that the hard drive mechanism doesn’t 
have to waste time moving to free areas of the drive during video 
capture. Defragmenting can be done with most good disk utility 
software.
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DV Video

DV device control

If your video input is a DV device you will have an extra option 
in the Window menu called 'DV Device Control', selecting it 
will display this floating window:

This gives you standard transport buttons for controlling the 
tape in the DV device, and easy access to DV input and DV 
output features.

Clicking on the button on the right will display a popup menu 
containing controls such as fast rewind, eject, and all available 
play modes supported by your DV device.

This popup menu also contains the option 'Wind tape to 
timecode', selecting it will display this dialog box:

This allows you to enter a timecode in the form 
hours:minutes:seconds and BTV Pro will then wind the tape to 
that timecode.

All the above controls, including DV stream capture and output, 
can be accessed by AppleScript. For more information please see 
the AppleScript section of this manual.
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DV stream capture

Source
You can choose 'Live video' to capture live DV video, or 'Tape' 
to capture from the tape in the DV device. If you select 'Tape' 
then BTV Pro will automatically start the tape playing.

Tape start time
If you are capturing from tape and you enter a timecode here, 
BTV Pro will wind the tape to this timecode before capturing.

Duration/End time
You can enter a capture duration or, if you are capturing from 
tape, you can enter a tape end timecode.

This feature captures a DV stream from a DV device; it 
effectively downloads the raw DV data directly from the device 
to your hard drive, resulting in a very reliable capture. The 
captured DV stream can be played back by BTV Pro or directly 
imported into other video software such as Apple's iMovie.

This feature is available from the button in the DV Device 
Control floating window or by selecting 'Capture DV stream' in 
the Capture menu. You will get this setup window:



39

DV stream output

Abort at break in timecode
If you are capturing from tape and check this option then the 
capture will be aborted if a break in timecode on the tape is 
detected.

File Name
This is the file name of the DV stream that will be saved to your 
hard disk.

Capture destinations
Clicking this button will give you the standard Capture 
Destinations window that allows you to choose multiple 
destinations for the capture.

Convert to QuickTime movie after capture
If you turn on this option the DV stream will be converted into a 
QuickTime movie after capture. This is useful if you want to 
open the captured file in other software that supports QuickTime 
movies but not DV streams (such as Apple's iDVD software).

This feature outputs a DV stream (or a QuickTime movie 
containing a DV stream) to a DV device.

This feature is available from the button in the DV Device 
Control floating window or by selecting 'Output DV stream' in 
the Capture menu. You will be asked to select a DV stream or 
movie to output and then you will get this setup window:
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Destination
You can choose 'Live video' to output live video, or 'Tape' to 
output to the tape in the DV device. If you select 'Tape' then 
BTV Pro will automatically start the tape recording.

DV stream start time
You can start the DV stream playing at any point by entering a 
timecode here.

Tape start time
If you are outputting to tape and you enter a timecode here, 
BTV Pro will wind the tape to this timecode before outputting. 
Note that tape will only have a timecode if it has been 
previously recorded.

Duration
You can enter a duration for the DV output.

Wait for device before starting
The device will take some time to switch into the right mode 
and/or start the tape recording before it is ready to receive 
video. The amount of time needed varies so you can enter a 
delay here that works best for your device.

Another way to output a DV stream (or a QuickTime movie 
containing a DV stream) is to open the DV stream or movie in 
BTV Pro and turn on the option 'Output to FireWire' in the 
Movie menu. Then you can play the movie to FireWire and still 
have access to the movie controller so you can jump to any point 
in the movie, fast forward, rewind, etc.

When output to FireWire is enabled for a movie there are two 
additional options in the Movie menu:

• Also play to window: plays the movie to the movie window as 
well as to the DV device. Turning this option off improves 
performance.

• Sound on: outputs sound to the DV device as well as video.
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Manipulating movies and images

Opening QuickTime movies

You can open a movie file by using the open command in the 
file menu, by dragging a movie file onto the BTV Pro icon in 
the Finder, or by capturing a movie from the video input. When 
you open a movie it is displayed in its own window with a 
QuickTime controller. The appearance of the controller depends 
on what version of QuickTime is installed on your computer, 
but the functionality is the same. It will look something like this:

You can use the arrow keys on the keyboard to step through the 
frames of the movie, and the space bar to start and stop the 
movie. There are also shortcut keys to fast forward and rewind 
the movie - choose ‘Keyboard shortcuts...’ from the Settings 
menu for a list of all keyboard shortcuts.

Sound volume
(hold shift key to make sound 
louder than normally allowed)

Play/pause

Position cursor

Step backward one frame
(hold command key to play 
movie backwards)

Step forward one frame
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Creating QuickTime movies

You can create a new movie by selecting ‘New movie...’ from 
the File menu. You will be asked where to save the movie, and a 
new movie file with no tracks will be created and opened.

When you add an image or paste a movie segment into the new 
movie a new track will be created with the dimensions of the 
image or movie segment.

Saving and exporting QuickTime movies

By default, movies are saved normally, possibly containing 
references to other movies (for more information about 
references see page 7).

When you choose ‘Save as...’ from the file menu to save a movie 
there is an option called ‘Flatten’. If this option is checked then 
the references in the movie are resolved and the resulting movie 
is entirely self-contained, with no references. Saving the movie 
in this way has the added advantage that all tracks are re-
interleaved for optimum playback performance and any unused 
data in the movie is removed.

To export the movie choose “Export movie...” from the File 
menu. You will be able to choose new sound and video settings, 
adjust the movie size, and apply filters. You can also use the 
Export feature to save a movie as a sequence of images, a DV 
stream, or a hinted movie ready for streaming over the Internet.

For information on how to save individual frames from a 
movie, see ‘Saving and exporting image files’ on page 47.

Converting DV streams into QuickTime movies

You can select this option from the File menu to convert any 
DV stream into a QuickTime movie. This is useful if you want 
to open the DV stream in software that supports QuickTime 
movies but not DV streams (such as Apple's iDVD software). A 
movie resource is added to the file without the DV data itself 
being processed, avoiding the lengthy export operation normally 
needed for this conversion.
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Stop-motion animation

Copy-and-paste editing

You can edit movies using simple copy-and-paste or drag-and-
drop operations. To select a portion of a movie hold down the 
shift key as you drag the position cursor or as you step through 
frames:

Now a portion of the movie is selected and you can use the copy 
command (in the Edit menu) to copy it to the clipboard, and the 
paste command to paste it into another movie (or to a different 
place in the same movie). Alternatively you can drag and drop 
from one movie to another.

When you edit in this way, you are placing references to the 
source movie into the destination movie, rather than the actual 
movie data itself. If you need to reuse portions of the same 
movie several times, using references saves disk space. The 
disadvantage with using references is that movies may not play 
properly if they refer to other movies that are missing. for 
more information about references see page 7.

There are two ways to make a stop-motion animation in BTV Pro: 
you can create a new movie and add frames to it, or you can 
capture image files first and then compose them into a movie later.

The advantage of making a movie as you go along is that you can 
instantly play back what you have animated, and you have access to 
the onion skin feature (described below). To add frames you can 
use the ‘Add one frame’ command in the Movie menu, or you can 
define your own shortcut key to add a frame (go to ‘Keyboard 
shortcuts’ under the Settings menu to see and adjust the keyboard 
shortcuts).
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The current frame 
capture count

Click here to reset 
the count to 0.

Click here to set 
the count to a 
particular value.

When you add a frame to a movie it is compressed using the 
compression settings that you have set in the Video Settings 
window (under the Settings menu). Note that if you choose the 
compression codec that is supplied by your video input hardware 
then no recompression is performed; the raw data directly from 
the video input hardware is added to the movie. This is mainly 
relevant for DV sources: in this case, if you choose DV 
compression in the Video Settings window, then no recompression 
is performed when adding frames to a movie. This ensures that 
there is no image degradation. To see if your video input 
hardware supplies compressed video select ‘Video hardware 
information’ under the Apple menu; this displays the default 
codec.

Frames are added to movies with the fps (frames per second) set 
in the preferences (see page 69).

The onion skin feature displays the last captured frame 
superimposed over the current video input. This is very useful for 
checking and precisely adjusting changes between consecutive 
frames. To activate the onion skin feature you must have a movie 
open with at least one frame already captured, then select ‘Onion 
skin’ from the Movie menu.

You can also create a stop motion animation by capturing a series 
of separate image files and then creating a movie out of them. 
While doing this it is useful to keep a count of the number of 
frames that you have captured; for this purpose there is a “Frame 
Capture Count” floating window, available under the Window 
menu:
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Once you have captured a series of image files you can make them 
into a movie with the “Make movie from folder of images...” 
option in the File menu. You will get this window:

This will take all the image files in the specified folder in 
alphabetical order and make them into a movie. The images are 
compressed with the specified compression settings and made into a 
movie with the specified FPS. The dimensions of the movie is based 
on the first image; if the subsequent images are different dimensions 
they will be scaled. The images can be in any image file format.

You can have the best of both worlds and capture straight to a movie 
while generate separate image files at the same time. The advantage 
of doing this is that you get the flexibility of having separate image 
files as well as instant playback of your animation as you go along 
and access to the onion skin feature. There is a shortcut key that you 
can define to do this (go to ‘Keyboard shortcuts’ under the Settings 
menu to see and adjust the keyboard shortcuts).
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The Frame Position floating window

If you select ‘Frame Position’ from the Window menu this 
floating window appears displaying time code and frame count:

The time code is in the format hours:minutes:seconds.frames. 
This information is updated as the movie is played or as the 
movie position cursor is dragged.

You can enter a time value or frame count into this window to 
jump to a specific time in the movie.

The frames value displayed in the timecode is calculated from 
the fps you have specified in the preferences (see page 69).

Note that when this window is open movie playback will be 
slower since calculating the frame count takes time.

The undo command

An undo/redo feature is available (from the Edit menu) for any 
edit function that is performed.

It should be noted however that if you add a frame to a movie 
and then use the undo function the frame is removed from the 
video track but the actual image data remains (unused) in the 
movie file. To remove all unused data from the movie file go to 
‘Save as...’ in the File menu, turn on the ‘Flatten’ option, and 
save the movie.
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Opening image files

BTV Pro can open image files of many different formats 
including PICT, JPEG, GIF, Photoshop, TIFF, PNG and BMP. 
You can then copy and paste them into movies and they are 
automatically resized and recompressed before being added to 
the movie.

BTV Pro can save image files in many different formats 
including PICT, JPEG, Photoshop, TIFF, PNG and BMP (the 
number of formats available depends on the version of 
QuickTime that you have installed on your computer).

To save an open image choose ‘Save’ from the File menu, and to 
export an image file (either from an open movie at its current 
position or from an open image) choose ‘Export image...’ from 
the file menu.

You will be able to set the file format and other settings relating 
to the file format (such as quality setting for JPEG images, for 
example). The only difference with saving and exporting is that 
the image is open after it is saved, but it is not opened after it is 
exported.

Saving and exporting image files
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Folder viewer

The folder viewer feature displays resizable thumbnails of all 
the image files in a folder and any subfolders within it. To 
access the folder viewer select ‘View folder of images’ from the 
File menu - you will then be asked to select a folder containing 
image files.

You can delete or rename an image file straight from the 
viewer, or double click on an image to display it full size. You 
can also drag images from the viewer onto other applications or 
onto movies in BTV Pro.

To save all the thumbnails as a single image file choose 'Save' 
from the File menu - you will be asked to choose a format and 
location for the image file. You can also print the thumbnails by 
choosing 'Print' form the File menu. If you select a thumbnail 
and choose 'Clear' from the Edit menu it is removed from the 
view but the original image file is not deleted.

Exporting movie files for Apple’s iMovie

To open a movie created by BTV Pro in Apple’s iMovie software 
you need to first export the movie as a DV stream. To do this go 
to ‘Export movie’ under the File menu and select ‘Movie to DV 
stream’ from the options at the bottom of the window. Make sure 
you select the correct format setting (DV-PAL or DV-NTSC) 
depending on which format you are using in iMovie. Then, in 
iMovie, select ‘Import’ from the File menu and choose the DV 
stream that you have just created.

Alternatively, if you use the DV stream capture feature (page 38) 
to capture video from a DV device then the resulting file can be 
imported directly into iMovie.

When you import a file into iMovie a duplicate copy is made in 
the Media folder within your iMovie project folder. To avoid this 
copy (which will take time and fill up your hard disk) you can 
manually move the DV stream file created by BTV Pro to the 
Media folder; when you then open the project in iMovie the DV 
stream will be added to the project without the creation of a 
duplicate file.
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AppleScript

Basics

AppleScript is a way of controlling an application either from a 
written script or from another application. Once you get the hang 
of it it is easy and quick to write your own scripts that can control 
BTV Pro. To write scripts you can use Apple’s ‘Script Editor’ 
application (it is installed as a part of the Macintosh operating 
system and should be in the folder ‘Apple Extras’ on your hard 
drive).

Once you open the Script Editor you should see a window like the 
one below. The ‘tell’ and ‘end tell’ commands are needed to 
define which application you are controlling, in this case BTV 
Pro. Everything you want to tell BTV Pro goes between these 
commands.

To see all available commands choose ‘Open Dictionary...’ from 
the File menu in Script Editor and select BTV Pro. Script 
Editor will show you all commands with a brief description of 
each one.
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Concepts

An object is any distinct item that can be modified or 
interrogated using AppleScript. Movies, images and windows are 
objects.

Each object has a number of properties. Each property defines a 
different characteristic of the object. For example the window 
object has properties including name and position.

Objects can be referred to by name or by number. Whenever you 
open a movie or an image it is assigned a unique number so that it 
can be identified. Also, each window has a unique number.

To make things easier, “movie 0” refers to the most recently 
opened movie, “image 0” refers to the most recently opened 
image, and “window 0” refers to the video input window. So if 
you are working with only one movie (or image) at a time then 
you don’t have to worry about the numbers.

If you are working with more than one movie (or image) at a 
time then you can either refer to the movies by name or by their 
unique number. An easy way to get the movie number is to 
remember the return value from the open command:

set movieNum to (open file “Hard disk:Movie name.mov”)
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Launching BTV Pro

The two commands that you can use to launch BTV Pro are 
activate and launch.

If you tell BTV Pro to activate it loads up and come to the 
front. In fact, any time you tell BTV Pro to activate it comes 
to the front.

If you tell BTV Pro to launch it loads up in the background 
with no open windows and awaits further instructions. The 
launch command is useful if you want to define the viewing 
mode (full screen or window mode) before BTV Pro switches 
to the mode that was last used.

General commands

q u i t

Tells BTV Pro to quit. If there are open movies that need to be 
saved BTV Pro displays a window for each movie asking if you 
want to save it before quitting. To prevent the display of these 
windows you can specify a saving method when issuing the quit 
command. The three possibilities are:

quit  saving yes
quit  saving no
quit  saving ask

open

Tells BTV Pro to open a file (it could be a movie file or an 
image file). For example:

open file “Hard disk:Documents:Movie1.mov”
open file “Hard disk:Documents:Image1.jpg”

The open command returns the movie number if you opened 
a movie, or the image number if you opened an image.
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save

Tells BTV Pro to save a movie, for example:

save movie 1
save movie “Movie name”

close

Tells BTV Pro to close an object. The object can be a movie, an 
image, or a window. For example:

close movie 1
close window 0

When closing a movie you can specify a saving method:

close movie 1  saving no

p r i n t

Tells BTV Pro to print an object. The object can be a movie, an 
image or a window.

full screen mode / window mode

Sets the video display to full screen mode or window mode

pause / resume

Pauses or resumes the video display

hide mouse / show mouse

Hides or shows the mouse cursor. Only available in full screen 
mode.

mute on / mute off

Turns the sound mute on or off
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set volume to

Sets the computer speaker volume to a value between 0 and 7, 
for example:

set volume to 5

blank other monitors / show other monitors

Turns on or off monitor blanking

set width / set height

Sets the current video dimensions. For example:

set width to 640
set height to 480

In window mode this resizes the window to the specified size; in 
full screen mode this adjusts the video display and centres it on 
the screen.

capture frame

Captures a frame of video to the hard drive. Uses the current 
setting for frame capture that are set in the preferences. You 
can optionally specify a path and/or file name for the destination 
file, and specify whether you want any previous file to be 
overwritten with the new image file:

capture frame
capture frame as “Hard disk:image1”
capture frame with overwrite

copy

Copies a frame from the video input to the clipboard. This only 
works if BTV Pro is the front application so you need to use the 
activate command before using the copy command.
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start recording

Starts recording a movie. As with frame capture you can 
optionally specify the file name and/or path:

start recording
start recording as “My Movie”

stop recording

Stops a movie record operation.

add frame to

Adds a frame or frames to a movie from the video input. You 
can optionally specify the number of frames to add:

add frame to movie 0
add frame to movie 0 times 10

p lay

Plays a movie, for example this plays the most recently opened 
movie:

play movie 0

stop playing

Stops playing the movie that is currently playing. You do not 
need to specify the movie.

set video input device

Sets the current video input device to the name specified. To see 
the names of all video input devices available on your system go 
to ‘Video Settings...’ under the Settings menu and look at the 
source options. The name is not case sensitive.

set video input device “built-in”
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DV stream capture / DV device control

play dv device

Sends a play command to the DV device.

stop dv device

Sends a stop command to the DV device.

wind dv device to

Winds the tape to a particular timecode. The timecode is 
specified as a list of format {hours,minutes,seconds}, for 
example:

wind dv device to {0,10,5}

get dv tape time

Returns the current tape time as a list of format 
{hours,minutes,seconds}

capture dv stream

Captures a DV stream to the hard drive. If you specify a start 
time then BTV Pro will automatically wind the tape to the start 
time before capturing. You can also specify the file name and 
capture duration, for example:

capture dv stream as "Filename.dv" start time {0,2,0}
duration {0,10,30}

output dv stream

Outputs a DV stream to a DV device. You have to specify the 
file name of the DV stream (you can use a full path or a partial 
path relative to the first movie capture destination). You can 
also specify whether the destination of the video is live or tape - 
if you specify tape then BTV Pro will start the DV device 
recording automatically.

output dv stream "Filename.dv" destination tape
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The convert  command

The times for some of the properties of movies are expressed as a 
list of format {hours,minutes,seconds,frames}.

If you want to deal with seconds or frame numbers instead of this 
time format, you can use the convert command to convert this 
time format to and from a number of seconds, and to and from a 
number of frames. For example:

convert time {0,3,0,10}  in movie 0  to seconds

This returns the number of seconds that corresponds to the time 3 
minutes and 10 frames in the movie.

convert time {0,10,0,0}  in movie 0  to frames

This returns the frame number that corresponds to the time 10 
minutes in the movie.

You can also use the convert command to convert between 
seconds and frames, for example:

convert frame number 100  in movie 0  to seconds

This returns the number of seconds corresponding to the frame 
number 100 in the movie.

The convert function is useful for setting the current time of the 
movie when you want to easily set a particular frame number or a 
particular number of seconds. For example:

set current time of movie 0 to (convert frame number
200 in movie 0  to time)
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The get  and set  commands

These commands are used to get and set the properties of an 
object. To view all properties for the objects go to Script 
Editor, choose ‘Open Dictionary...’ from the File menu and 
select BTV Pro. Below are some examples of commands that 
involve common properties that are likely to be useful:

Moving Windows

Each window have a position and bounds property; the 
position property is a point that defines the top left corner of 
the window, the bounds is a rectangle that defines the complete 
bounds of the window. For example:

set position of window 0 to {400,100}

This sets the position of the video input window to the 
coordinates {400,100}. Note that the top left of the main 
monitor is {0,0}

Playing Movies

This can be done with the play movie command (described 
above), but also each movie has a play status property that is 
true if the movie is playing or false if it is not. This can be used 
to check if a particular movie is playing, or to start and stop a 
movie. The following example stops movie 0 if it is currently 
playing, and starts it if it is not currently playing:

if (get play status of movie 0) is false then
set play status of movie 0 to true

else if (get play status of movie 0) is true then
set play status of movie 0 to false

end if

Setting the current time of movies

Each movie has a current time and a current seconds 
property. The current time property is expressed as a list of 
format {hours,minutes,seconds,frames}, the current seconds 
property is expressed as a number of seconds. You can convert 
between the different formats using the convert command. For 
example:
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set current time of movie 0 to {0,10,2,0}
set current seconds of movie 0 to 0
set current time of movie 0 to {0,0,0,0}
set current time of movie 0 to (get duration of movie 0)
set current time of movie 0 to (convert frame

100 in movie 0 to time)

Setting FireWire output status

Each movie has a firewire output status property that can be 
set to true or false to turn on and off output to FireWire for the 
movie. To use this property the movie must contain a DV 
stream and your computer must have FireWire output 
hardware.

set firewire output status of movie 0 to true
set firewire output status of movie 0 to false

There are two further options for FireWire output, defined by 
the firewire output preview status and firewire output 
sound status properties. The firewire output preview status 
property defines whether the video is played on the computer as 
well as output to FireWire, and the firewire output sound 
status property defines whether the sound is also output to 
FireWire with the video:

set firewire output preview status of movie 0 to false
set firewire output sound status of movie 0 to true

Setting the loop status of movies

Each movie has a loop status setting that defines if the movie is 
set to loop or not. If true, the movie will start again from the 
beginning when it gets to the end.

set loop status of movie 0 to true
set loop status of movie 0 to false
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If you have a TurboTV, ixTV or ixTV/FM card then you can 
control channel changing with AppleScript.

Setting the channel

You can set the channel by number using the channel command 
or by name using the channel name command, for example

channel 4
channel name “BBC 1”

Getting the current channel

You can determine what the current channel is by using the get 
current channel command. This returns the number of the 
current channel. For example, the following command increases 
the channel number by 1:

channel (get current channel + 1)

Channel changing
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If your video input is an ixMicro ixTV, ixTV/FM, or TurboTV 
tuner card there will be an extra menu in the menu bar called 
‘Channel’:

In the above menu 10 channels are set up and can be selected either 
from this menu or using the number keys on the keyboard. Channel 
10 can be selected by pressing 1 quickly followed by 0.

To set up channels choose the ‘Channel setup...’ option from the 
bottom of the menu. You will get this window:

Channel changing with the ixTV card
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From this window you can add a new channel, or edit or 
remove an existing channel. When you click the ‘Add’ or the 
‘Edit’ button you will get the following window that allows you 
to set up the the channel:
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Location

There are 100 locations to store channels. You do not have to 
number the channel sequentially; you can use any location you 
like from 0 to 99.

1

2

3

4

5

6

7

Name

This can be any name you like to describe the channel. It can be 
up to 29 characters long.

1

2
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3

4

5

6

7

Channel set

This defines the set of frequencies that are used for the signal 
transmission channel number. Choose the one that best matches 
your input signal. The choices are:

• US
• US cable
• Western Europe
• France
• Japan
• Japan cable
• Australia
• Russia

Signal transmission channel

Each TV station transmits its signal on a particular signal 
transmission channel. These signal transmission channels are 
different for each channel set. If you know the signal transmission 
channel for a particular TV station you can simply select it from 
the list, otherwise you can go through the list looking for TV 
stations.

Scan for blank channels

This goes through each signal transmission channel and looks for 
a TV station. If no TV station is found then the channel is 
removed from the list. Therefore, after this operation is complete 
only the signal transmission channels that transmit a TV station 
are available in the list.

Hide blank channels in list

Once blank channels have been removed from the list with the 
‘Scan for blank channels’ function, this option turns on and off 
the display of the blank channels in the list.

Fine tune

Use this function to adjust the tuning to get the best possible video 
and sound quality. Hold down the Apple (command) key while 
using this control to adjust the fine tune twice as much as normal.
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Preferences

The preferences window is available by selecting ‘Preferences...’ 
from the Settings menu. There are four sections:

• General
• Frame capture
• Movies
• Monitor settings

General
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Use sound
This option controls whether the computer’s sound hardware is 
initialised. You can turn this option off if you don’t use your 
computer for playing sound while watching video.

Remember sound volume
This option controls whether the computer speaker volume is to 
be remembered the next time you use BTV Pro.

Hide cursor
If this option is on then the mouse cursor is hidden when 
switching to full screen mode.

Spin down hard disks
If this option is on then the computer’s hard disk(s) is spun 
down when switching to full screen mode.

Add file extensions
When this option is on BTV Pro automatically adds three-
character file extensions to the names of all files that are 
created. These file extensions are needed by Windows PCs to 
determine the file type, so if you are sending files to a PC then 
this option should be on.

High quality live video enabled
This setting tells the video hardware to play the video in high 
quality mode. This option is mainly applicable to DV video 
sources although it might be used for other video hardware as 
well. If your video hardware supports this setting turning then 
turning it on increases playback quality at the expense of 
performance. Note that this option only applies to playback and 
not capture.

Live window dragging
Turning the option on enables all windows to be drawn and 
updated as they are dragged.

Use more processor time
When this option is on BTV Pro uses as much processor time as 
possible to ensure smooth playback of video. This is only for 
playback; it automatically happens during capture.
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Frame capture

Capture destinations
Clicking this button shows a window allowing you to choose the 
capture destinations. See below for a full explanation of capture 
destination options.

Format
This pop-up menu allows you to choose the format of the image 
files. For full details of all available image formats see page 17.

Options
Clicking this button shows a window allowing you to adjust the 
settings for the particular image format that is selected. The 
number and type of settings available vary depending on the 
image format, but generally include colour depth and other 
relevant settings such as quality.
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Name
This option selects the type of automatic name used for saving 
image files. If ‘Data stamped’ is chosen then the filename contains 
the date in the format “day|month hour|minute|second”, if 
‘Numeric’ is chosen then the files are incrementally numbered 
“001”, “002” up to “9999”.

Creator
The creator is a four-character code that defines the application 
that owns the file, so that if you double-click on the file it 
automatically opens in that application. You can define the creator 
for image files by selecting one listed in the pop-up menu, typing 
in the code, or clicking the ‘Make like...’ button and selecting a 
similar file or the desired application.

Image capture method
There are three different ways to capture an image. These are 
labelled in this menu as:

• QuickTime: Uses the standard QuickTime frame grabbing 
routine to capture an image. This should work reliably but is 
inefficient and therefore likely to be slow (it is especially slow 
when used with USB devices).

• BTV: Uses BTV Pro's own routines to capture the frame which 
is often significantly faster than the QuickTime method.

• Directly from screen: This is very fast but if there are other 
windows in front of the video or the video is partially off screen 
then this will appear in the captured image. There is no loss of 
quality when capturing from the screen but the maximum colour 
depth of the captured image is determined by the color depth of 
the screen. You can use this method to capture frames even during 
a movie capture; since the image comes from the screen it doesn’t 
affect the video input at all.

Always capture frames at..
You can make all captured frames a set size by entering the size 
here. This applies to normal frame captures as well as frames 
captured during time lapse. If you don't specify a size here then 
captures will be at the current size of the video input window.

Open image file after creation
If this option is on then the image file is be opened after it is 
created.
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Play click sound after capture
If this option is on a click sound is played when a frame is 
captured.

Deinterlace captured and exported frames
Analogue video (PAL, NTSC and SECAM) is interlaced, that is, 
each frame of video is made up of two fields on alternate 
horizontal lines. DV video can also be interlaced. Since there is a 
time delay between the two fields, if there is motion in the frame 
this will show up as jagged lines in the area of the motion. If this 
option is turned on BTV Pro will automatically deinterlace any 
frames captured from the video input, exported from a movie, or 
copied to the clipboard. This is done by eliminating the odd field 
and creating a new odd field by interpolating pixels in the even 
field.

Number of frames to average
Determines the number of frames used for the frame averaging 
feature. Enter 0 to average frames indefinitely.
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Capture destinations
When you click this button a window is shown allowing you to 
choose the capture destinations. See below for a full explanation 
of capture destination options.

Split into 2GB files
When this option is on then the capture is automatically split 
into separate 2GB files. This option applies to all movies 
captured by BTV Pro, as well as the DV stream capture feature.

Movies
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If you have OS9 and QuickTime 4 or later installed on your 
computer and you are capturing to an HFS+ disk (sometimes 
called a “Mac OS Extended” format disk) then you can capture 
files larger than 2GB in size. If not, then captures are 
automatically split into separate 2GB files even if this option is 
turned off. Even if you can capture larger than 2GB files, it is  
difficult to transfer these files over networks to other 
computers, so this option is useful in these circumstances.

When the capture has been split into several files an index is 
added to the files so that you know the order in which they were 
captured. For example, if the main file name is “My Movie” 
then the other files are named “My Movie-01”, “My Movie-02” 
etc. For normal movie captures you can only open the first file 
but it contains the data of all the files; for other captures (time 
lapse, motion detection, DV stream capture) each file is an 
independent movie file that can be opened individually.

Limit capture time
You can enter a time here to limit the total capture time for 
normal movie captures (not timelapse, motion detection or DV 
stream capture since these have separate capture time settings). 
When the time has elapsed the capture is automatically stopped.

Name
This option selects the type of automatic name used for saving 
image files. If ‘Data stamped’ is chosen then the filename 
contains the date in the format “day|month hour|minute|second”, 
if ‘Numeric’ is chosen then the files are incrementally numbered 
“001”, “002” up to “9999”.

Creator
The creator is a four-character code that defines the application 
that owns the file, so that if you double-click on the file it 
automatically opens in that application. You can define the 
creator for image files by selecting one listed in the pop-up 
menu, typing in the code, or clicking the ‘Make like...’ button 
and selecting a similar file or the desired application.

Capture video / Capture sound
These options control whether sound and/or video are captured. 
One of them must be on. Note that for DV video sound and 
video are interleaved in the data stream and it is not possible to 
capture one without the other.
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Play video during capture / Play sound during capture
These options allow you to control whether sound and video are 
played during capture. Generally, turning these options off 
increases capture performance resulting in higher frame rates 
(smoother, less ‘jerky’ video).

Display settings before
When this options is on all capture settings are displayed and can 
be adjusted before every movie capture.

Open movie after
If this option is on then the movie file is be opened after it is 
captured.

FPS used for displaying timecode
Time code is displayed in the Frame Position window in the 
form hours:minutes:seconds.frames. This fps setting is used to 
calculate the frames value in the timecode. Set this depending on 
what video format you are using (PAL and SECAM use 25 fps, 
NTSC uses 29.97 fps).

FPS used when adding frames to movies
This FPS setting is used whenever a frame is added to a movie; 
it defines the duration of the added frame.

Always add frames to end of movie
If this option is on then any new frames added to the movie 
from the video input will be added at the end of the movie. If 
this option is off then frames are added at the current position.

Average
You can turn this option on and enter a value to average a 
certain number of frames when an image to a movie. This is 
useful for creating animations with clean, noise-free frames.

Play click sound after
If this option is on then a click sound is played whenever you 
add a frame to a movie.
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Capture destinations

This window is available from the frame capture options and 
movie capture options in the preferences, as well as in the Time 
Lapse and Motion Detection setup windows. It allows you to 
choose destinations for capture movie and image files.

If you have many hard disks connected to your computer you can 
use the movie capture destinations to capture to up to three of 
your hard disks in a row; when the first is full the second is used 
and when that is full the third is used.

When the capture has been split into several files an index is 
added to the files so that you know the order in which they were 
captured. For example, if the main file name is “My Movie” then 
the other files are named “My Movie-01”, “My Movie-02” etc. 
You can only open the first file but it contains the data of all the 
files.
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Use monitor
This pop-up menu allows you to choose which monitor is used for 
full screen video.

Identify monitors
Pressing this button displays numbers on each monitor to identify 
them.

Full screen depth setting
The monitor is switched to this colour depth when viewing full 
screen video. Depending on the particular video hardware in use, 
most users should choose Thousands or Millions; the 256 option is 
included for completeness and to retain compatibility with certain 
older video input devices.

Monitor settings
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Resolution menus
There is a pop-up menu for each of your monitors allowing you 
to choose the monitor resolution for full screen video. If the 
resolution is shown in italics it needs to be confirmed the first 
time it is used to make sure that it is supported by your monitor.
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